	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	ĐỀ KIỂM TRA HỌC KÌ I
Môn: Tin học – Lớp 7 (Đề lý thuyết)
Thời gian: 45 phút



I.MỤC TIÊU: 
1.  Kiến thức: 
+ Chương trình bảng tính, các kiểu dữ liệu trên trang tính.

+ Các hàm: Sum, Average, max, min.

+ Các thao tác trong bảng tính.

2.  Kỹ năng: 
       HS biết vận dụng các kiến thức để giải quyết các bài tập: Biết cách nhập dữ liệu vào bảng tính, sử dụng các công thức, các hàm để tính toán.
3.  Thái độ: 
   -  Nghiêm túc trong khi kiểm tra 
   -  Không sử dụng tài liệu 

II. MA TRẬN ĐỀ KIỂM TRA: 
 
	             Cấp độ 
Nội dung   
	Nhận biết
	Thông hiểu
	Vận dụng
	Vận dụng cao
	Tổng



	
	TN
	TL
	TN
	TL
	TN
	TL
	TN
	TL
	

	Chương trình bảng tính

Các thành phần chính và dữ liệu trên trang tính.
	2

(1)
	
	
	1

 (2đ)
	
	
	
	
	3
(3đ)

30%

	Các thao tác cơ bản với chương trình bảng tính Excel.
	2

 (1đ)
	
	1

 (0.5đ)
	
	
	
	
	
	3
(1,5đ)

15%

	Sử dụng công thức, hàm để tính toán
	1

 (0.5đ)
	
	2

 (1đ)
	
	
	1

 (2đ)
	
	1

 (2đ)
	5
(5.5đ)

55%

	Tổng
	5
(2.5đ)

25%
	
	3
(1.5đ)

15%
	1
(2đ)

20%
	
	1

(4đ)

20%
	
	1

(2đ)

20%
	11
(10)

100%


 
	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	BÀI KIỂM TRA HỌC KÌ I

Môn: Tin học – Lớp 7 (Đề lý thuyết)
Thời gian: 45 phút


I/TRẮC NGHIỆM(4 điểm):
               Hãy ghi vào giấy kiểm tra các đáp án mà em cho là đúng nhất. 
Câu 1: Khi các chữ số của dữ liệu kiểu số lớn hơn chiều rộng của ô thì Excel sẽ hiển thị trong ô các kí tự.

        A.& 


B. *



C. %


D. #

Câu 2: Để chọn đồng thời nhiều khối khác nhau, ta chọn khối đầu tiên rồi nhấn phím gì để chọn các khối tiếp theo?


A. Shift


B. Ctrl


C. Enter


D. Delete

Câu 3. Trong bảng tính Exel để xóa cột hàng ra khỏi trang tính, ta chọn hàng đó và thực hiện:


A.Nhấn Delete




B. Table -> Delete Rows


C.Edit ->  Delete



          D. Format -> Row
Câu 4. Trong các công thức tính trung bình cộng, công thức nào sai:
A. =Average(A1:A5)


B. =SUM(A1:A5)
C. = Average(A1:A5)/5


D. =(A1+A2+A3+A4+A5)/5

Câu 5 . Để thêm cột trên trang tính ta thực hiện như sau:

A. Insert / Rows         B. Insert / Columns
C. Table / Columns        D. Table / Rows

Câu 6. Giả sử ô B4 có công thức =Sum(A1:B3). Sao chép công thức ô B4 vào ô C4. Công thức trong ô C4 sẽ là:

A.   =Sum(A2:B4)
     B.   =Sum(A1:A3)
C.   =Sum(B2:C4)
       D.   =Sum(B1:C3)

Câu 7: Hộp tên trên trang tính cho em biết:

A. Nội dung của ô đang chọn



C. Địa chỉ của ô đang chọn

  B. Nhập dữ liệu




D. Nhập công thức
Câu 8. Khi nhập công thức vào một ô, kí tự nào là kí tự đầu tiên cần nhập?
       A. Dấu “ = ”

B. Dấu “ * ”

C. Dấu “ x ”


D. Dấu “/”

II/TỰ LUẬN (6 điểm)
Câu 9 (2.0 điểm): Hãy nêu các kiểu dữ liệu trên trang tính, cho ví dụ?
Câu 10 (1.5 điểm) : Bạn Xuân cho rằng: “ Hàm là công thức được định nghĩa từ trước”, bạn Mai lại nói “ Hàm được sử dụng để thực hiện tính toán theo công thức với các giá trị dữ liệu cụ thể, giúp việc tính toán dễ dàng và nhanh chóng hơn”. Theo em, ý kiến của bạn nào nói về định nghĩa hàm trong chương trình bảng tính? Em hãy viết hàm tính trung bình cộng giá trị các ô A2 đến ô A7? 
Câu 11 (2.5 điểm): Trường THCS Đô Thị Việt Hưng phát động phong trào thi đua tiết học tốt, hoa điểm 10 chào mừng ngày Nhà giáo Việt Nam (từ ngày 1/11 đến ngày 19/11/2016). Dưới đây là bảng tổng kết thi đua của khối 7 
	
	A
	B
	C
	D

	1
	STT
	Lớp
	Tiết học tốt
	Hoa điểm 10

	2
	1
	7A1
	30
	20

	3
	2
	7A2
	40
	31

	4
	3
	7A3
	39
	18

	5
	4
	7A4
	55
	35

	6
	5
	7A5
	37
	30


Em hãy viết các hàm:

a) Tính trung bình cộng tiết học tốt của tất cả các lớp.
b) Tính tổng hoa điểm 10 của tất cả các lớp.
c) Tìm số tiết học tốt lớn nhất, nhỏ nhất.
Chúc các em làm bài thi tốt!

	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	HƯỚNG DẪN CHẤM BÀI KIỂM TRA HỌC KÌ I

Môn: Tin học – Lớp 7 (Đề lý thuyết)
Thời gian: 45 phút



I/TRẮC NGHIỆM (4 điểm):

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	D
	B
	C
	B,C
	B
	D
	C
	A

	Điểm
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ


II/TỰ LUẬN (6 điểm)
	Nội dung
	Điểm

	Câu 9 : Các kiểu dữ liệu trên trang tính là :
· Dữ liệu số : là các chữ số 0,1,2, …,9, dấu cộng (+) chỉ số dương, dấu trừ (-) chỉ số âm, và dấu % chỉ tỉ lệ phần trăm

 Ví dụ : 135, -278
· Dữ liệu kí tự : là dãy các chữ cái, chữ số và các kí hiệu.

Ví dụ : học sinh lớp 7, Việt Nam.

Câu 10: - Bạn Xuân đúng: Hàm là công thức được định nghĩa từ trước

                   = Average(A1:A6)
Câu 11: 
a) =Average(C2:C6)

b) =SUM(D2:D6)

c) = MAX(C2:C6)

    = MIN(C2:C6)


	1đ

1đ

0,5đ
1 đ

1đ

0,5đ

0,5đ

0,5đ


	Ban giám hiệu
	TTCM

Nguyễn T Thu Phương
	NTCM

Chu Thị Nhung
	Người ra đề
Nguyễn Thị Thu Phương


	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	ĐỀ KIỂM TRA HỌC KÌ I

Môn: Tin học – Lớp 7 (Đề thực hành)
Thời gian: 45 phút



I.MỤC TIÊU: 
1.  Kiến thức: 
+ Các thao tác trong bảng tính.

+ Các hàm: Sum, Average, max, min.

2.  Kỹ năng: 
       HS biết vận dụng các kiến thức để giải quyết các bài tập: 
       + Biết cách nhập dữ liệu vào bảng tính.

       + Biết trình bày bảng tính.

       + Biết sử dụng các công thức, các hàm để tính toán.

       + Sao chép công thức
3.  Thái độ: 
       + Nghiêm túc trong khi kiểm tra 
       + Cẩn thận khi thực hành

4. Năng lực :

       + Phát triển năng lực tư duy, suy luận logic, tính thẩm mỹ
II. MA TRẬN ĐỀ KIỂM TRA: 
 
	             Cấp độ          

Nội dung   
	Nhận biết
	Thông hiểu
	Vận dụng
	Vận dụng Cao
	Tổng



	
	TN
	TL
	TN
	TL
	TN
	TL
	TN
	TL
	

	Nhập dữ liệu trên trang tính. Sao chép công thức

	
	
	
	1

 (3)
	
	
	
	
	1

(3đ)

30%

	Lưu dữ liệu.


	
	1

 (1)
	
	
	
	
	
	
	1
(1đ)

10%

	Dùng hàm để tìm giá trị cao nhất, điểm thấp nhất
	
	
	
	
	
	
	
	2

(2)
	2
(2đ)

20%

	Dùng hàm để tính tổng giá trị
	
	
	
	
	
	1
(2)
	
	
	1

(2đ)

20%

	Dùng hàm để tính giá trị trung bình 
	
	
	
	
	
	1

 (2)
	
	
	1

(2đ)

20%

	Tổng
	
	1

(1đ)

10%
	
	1
(3đ)

30%
	
	2
(4đ)

40%
	
	2

(2đ)

20%
	6
(10đ)

100%


	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	ĐỀ KIỂM TRA HỌC KÌ I
Môn: Tin học – Lớp 7 (Đề thực hành)
Thời gian: 45 phút



Cho bảng tính
[image: image1.png]Téng gid tri sin xuat

Nam Noug aghiép | Cong aghiép | Dich vy | Téag
2001 164031 542155 | 1049.45
2002 1703.66 740.99 | 1263.81
2003 1749.27 1361.65 | 1397.21
2004 188045 1597.52 | 1577.53
2005 2009.32 1886.06 | 1789.94
2006 1924.6 2356.67 | 2151.85
GTSX wwung biah
GTSX (6n abit

(GTSX nho nhat





Yêu cầu:

Câu1 (3 điểm): Nhập nội dung bảng tính theo mẫu trên. 
Câu 2 (1 điểm): Lưu với tên và đường dẫn sau: D:\Khoi 7\Họ và tên học sinh - lớp 
Câu 3 (2 điểm): Tính tổng giá trị sản xuất từng năm của các ngành
Câu 4 (2 điểm) : Tính giá trị sản xuất trung bình của từng ngành, sử dụng hàm để tính
Câu 5 (1 điểm) : Tính giá trị sản xuất lớn nhất từng ngành trong các năm 
Câu 6 (1 điểm): Tính giá trị sản xuất nhỏ nhất từng ngành trong các năm
	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	HƯỚNG DẪN CHẤM BÀI KIỂM TRA HỌC KÌ I

Môn: Tin học – Lớp 7 (Đề thực hành)
Thời gian: 45 phút


	
	


	Nội dung
	Điểm

	Câu1 : Nhập nội dung bảng tính theo mẫu trên. 
Câu 2: Lưu với tên và đường dẫn sau: D:\Khoi 7\Họ và tên học sinh-lớp 

Câu 3 :Dùng hàm để tính tổng giá trị sản xuất từng năm của các ngành 

                =Sum(D3:F3)
               - Sao chép công thức

Câu 4 :Tính giá trị sản xuất trung bình của từng ngành

=Average(C3:E3)
      (Tương tự với các điểm dưới)
Câu 5: Tính giá trị sản xuất lớn nhất từng ngành trong các năm 
=Max(C3:C8)
- Sao chép công thức
Câu 6: Tính giá trị sản xuất nhỏ nhất từng ngành trong các năm 
=Min(C3:C8)

- Sao chép công thức

	3đ

1đ

2đ

2đ

1đ

1đ



	Ban giám hiệu
	TTCM

Nguyễn Thị Thu Phương
	NTCM

Chu Thị Nhung
	Người ra đề 

Nguyễn Thị Thu Phương


	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	ĐỀ KIỂM TRA HỌC KÌ I
Môn: Tin học – Lớp 7 (Đề lý thuyết)
Thời gian: 45 phút



Đề 2

I.MỤC TIÊU: 
1.  Kiến thức: 
+ Chương trình bảng tính, các kiểu dữ liệu trên trang tính.

+ Các hàm: Sum, Average, max, min.

+ Các thao tác trong bảng tính.

2.  Kỹ năng: 
       HS biết vận dụng các kiến thức để giải quyết các bài tập: Biết cách nhập dữ liệu vào bảng tính, sử dụng các công thức, các hàm để tính toán.
3.  Thái độ: 
   -  Nghiêm túc trong khi kiểm tra 
   -  Không sử dụng tài liệu 

II. MA TRẬN ĐỀ KIỂM TRA: 
 
	             Cấp độ 
Nội dung   
	Nhận biết
	Thông hiểu
	Vận dụng
	Vận dụng cao
	Tổng



	
	TN
	TL
	TN
	TL
	TN
	TL
	TN
	TL
	

	Chương trình bảng tính

Các thành phần chính và dữ liệu trên trang tính.
	1

(0,5đ)
	
	
	1

 (2đ)
	
	
	
	
	1

(2đ)

20%

	Các thao tác cơ bản với chương trình bảng tính Excel.
	4

 (2đ)
	
	1

 (0.5đ)
	
	
	
	
	
	5
(2.5đ)

25%

	Sử dụng công thức, hàm để tính toán
	1

 (0.5đ)
	
	2

 (1đ)
	
	
	1

 (2đ)
	
	1

 (2đ)
	5
(5.5đ)

55%

	Tổng
	5
(2.5đ)

25%
	
	3
(1.5đ)

15%
	1
(2đ)

20%
	
	1

(4đ)

20%
	
	1

(2đ)

20%
	11
(10)

100%


 
	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	BÀI KIỂM TRA HỌC KÌ I

Môn: Tin học – Lớp 7 (Đề lý thuyết)

Thời gian: 45 phút


Đề 2

I/TRẮC NGHIỆM(4 điểm):
               Hãy ghi vào giấy kiểm tra các đáp án mà em cho là đúng nhất. 
Câu 1: Thông tin được lưu dưới dạng bảng có ưu điểm gì:

A. Tính toán đúng


      B. Dễ theo dõi.

C. Dễ sắp xếp


       D. Dễ sắp xếp, dễ theo dõi, tính toán nhanh chóng

Câu 2: Trên trang tính, để biết kết quả biểu thức 152 + 4 – 220 tại ô A1 nhập công thức:


A) 152 + 4 – 220

                                B)  = 15.15 +4 – 220


C) =15^2 +4 – 220
                                          D)  = 15*2 +4 – 220

Câu 3. Trong bảng tính Exel để xóa cột hàng ra khỏi trang tính, ta chọn hàng đó và thực hiện:


A.Nhấn Delete




B. Table -> Delete Rows


C.Edit ->  Delete



          C. Format -> Row
Câu 4. Trong các công thức tính trung bình cộng, công thức nào sai:
A. =Average(A1:A5)


B. =SUM(A1:A5)

C. = Average(A1:A5)/5


D. =(A1+A2+A3+A4+A5)/5

Câu 5 . Để thêm cột trên trang tính ta thực hiện như sau:

A. Insert / Rows         B. Insert / Columns
C. Table / Columns        D. Table / Rows

Câu 6. Giả sử ô B4 có công thức =Sum(A1:B3). Sao chép công thức ô B4 vào ô C4. Công thức trong ô C4 sẽ là:

A.   =Sum(A2:B4)
     B.   =Sum(A1:A3)
C.   =Sum(B2:C4)
       D.   =Sum(B1:C3)

Câu 7: Nếu một trong các ô tính có các kí hiệu #####, điều đó có nghĩa là gì ? 

A. Độ rộng của cột quá nhỏ không hiển thị hết dãy số quá dài.

B. Độ rộng của hàng quá nhỏ không hiển thị hết dãy số quá dài.

C. Tính toán ra kết quả sai

D. Công thức nhập sai.

Câu 8. Khi gõ công thức vào một ô, kí tự đầu tiên phải là:


A. Ô đầu tiên tham chiếu tới


B. Dấu ngoặc đơn


C. Dấu nháy





D. Dấu bằng

II/TỰ LUẬN (6 điểm)

Câu 9 (2.0 điểm): Hãy nêu các kiểu dữ liệu trên trang tính, cho ví dụ?

Câu 10 (2.0 điểm) : Hãy nêu cú pháp, chức năng các hàm SUM, AVERAGE, MAX, MIN ?

Câu 11 (2.0 điểm) Cho bảng tính sau:

[image: image2.png]5 x
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a. Sử dụng hàm hoặc công thức tính tổng các số 2, 3, 4 tại ô D1.

 (Sử dụng địa chỉ)

b. Khi sao chép công thức tại ô D1 sang ô F1,lúc đó tại ô F1 có công thức như thế nào?

Chúc các em làm bài thi tốt!
	PHÒNG GD& ĐT QUẬN LONG BIÊN

TRƯỜNG THCS ĐÔ THỊ VIỆT HƯNG

Năm học 2016 – 2017
	HƯỚNG DẪN CHẤM BÀI KIỂM TRA HỌC KÌ I

Môn: Tin học – Lớp 7 (Đề lý thuyết)
Thời gian: 45 phút



Đề 2

I/TRẮC NGHIỆM(4 điểm):

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	D
	C
	C
	B,C
	B
	D
	A
	D

	Điểm
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ
	0,5 đ


II/TỰ LUẬN (6 điểm)
	Nội dung
	Điểm

	Câu 9 : Các kiểu dữ liệu trên trang tính là :

· Dữ liệu số : là các chữ số 0,1,2, …,9, dấu cộng (+) chỉ số dương, dấu trừ (-) chỉ số âm, và dấu % chỉ tỉ lệ phần trăm
 Ví dụ : 135, -278
· Dữ liệu kí tự : là dãy các chữ cái, chữ số và các kí hiệu.
Ví dụ : học sinh lớp 7, Việt Nam.
Câu 10: 

* SUM -Tên hàm: SUM

              Cú pháp: =Sum(a,b,c)

              Trong đó: Các biến a,b,c là các số hay địa chỉ của các ô tính. 
                                Số lượng các biến là không hạn chế

             Công dụng: Tính tổng một dãy các số

* AVERAGE - Tên hàm: AVERAGE

                         Cú pháp: =AVERAGE(a,b,c...,)

                         Trong đó: Các biến a,b,c là các số hay địa chỉ của các ô tính.
                                          Số lượng các biến là không hạn chế

                         Công dụng: Tính trung bình cộng một dãy các số

* MAX - Tên hàm: MAX

               Cú pháp: =MAX(a,b,c,...)

               Trong đó: Các biến a,b,c là các số hay địa chỉ của các ô tính. 

                             Số lượng các biến là không hạn chế

               Công dụng: Xác định giá trị lớn nhất

* MIN -  Tên hàm: MIN

               Cú pháp: =MIN(a,b,c,...)

               Trong đó: Các biến a,b,c là các số hay địa chỉ của các ô tính. 

                             Số lượng các biến là không hạn chế

               Công dụng: Xác định giá trị nhỏ nhất
Câu 11: 

            a) D1=SUM(A1;B1;C1) 

b) Công thức là: F1=SUM(C1;D1;E1)
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Đề 2

I.MỤC TIÊU: 
1.  Kiến thức: 
+ Các thao tác trong bảng tính.

+ Các hàm: Sum, Average, max, min.

2.  Kỹ năng: 
       HS biết vận dụng các kiến thức để giải quyết các bài tập: 

       + Biết cách nhập dữ liệu vào bảng tính.

       + Biết trình bày bảng tính.

       + Biết sử dụng các công thức, các hàm để tính toán.

       + Sao chép công thức
3.  Thái độ: 
       + Nghiêm túc trong khi kiểm tra 
       + Cẩn thận khi thực hành

4. Năng lực :

       + Phát triển năng lực tư duy, suy luận logic, tính thẩm mỹ

II. MA TRẬN ĐỀ KIỂM TRA: 
 
	             Cấp độ          

Nội dung   
	Nhận biết
	Thông hiểu
	Vận dụng
	Vận dụng Cao
	Tổng



	
	TN
	TL
	TN
	TL
	TN
	TL
	TN
	TL
	

	Nhập dữ liệu trên trang tính. Sao chép công thức

	
	
	
	1

 (3)
	
	
	
	
	1

(3đ)

30%

	Lưu dữ liệu.


	
	1

 (1)
	
	
	
	
	
	
	1
(1đ)

10%

	Dùng hàm để tìm giá trị cao nhất, điểm thấp nhất
	
	
	
	
	
	
	
	2

(2)
	2
(2đ)

20%

	Dùng hàm để tính tổng giá trị
	
	
	
	
	
	1
(2)
	
	
	1

(2đ)

20%

	Dùng hàm để tính giá trị trung bình 
	
	
	
	
	
	1

 (2)
	
	
	1

(2đ)

20%

	Tổng
	
	1

(1đ)

10%
	
	1
(3đ)

30%
	
	2
(4đ)

40%
	
	2

(2đ)

20%
	6
(10đ)

100%
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Đề 2

Cho bảng tính
	
	A
	B
	C
	D
	E
	F
	G

	1
	BẢNG ĐIỂM MÔN TIN HỌC CĂN BẢN

	2
	STT
	Họ và tên
	Toán
	Văn
	Tin học
	Tổng điểm
	Trung bình

	3
	1
	Nguyễn Minh Anh
	10
	8.5
	8
	?
	?

	4
	2
	Trần Thanh Mai
	7
	9
	8.5
	?
	?

	5
	3
	Nguyễn Hải Nam
	9
	8
	6.5
	?
	?

	6
	4
	Lê Minh Quang
	9
	8
	5
	?
	?

	7
	5
	Nguyễn Thị Thúy
	7
	9
	10
	?
	?

	8
	6
	Trần Mai Lan
	7
	6
	5
	?
	?

	9
	7
	Lê Thanh Hoa
	6.5
	9.5
	7
	?
	?

	10
	
	Điểm cao nhất
	?
	?
	?
	
	

	11
	
	Điểm thấp nhất
	?
	?
	?
	
	


Yêu cầu:

Câu1 (3 điểm): Nhập nội dung bảng tính theo mẫu trên. 
Câu 2 (1 điểm): Lưu với tên và đường dẫn sau: D:\Khoi 7\Họ và tên học sinh - lớp 
Câu 3 (2 điểm) : Dùng hàm để tính tổng ba môn của mỗi học sinh 
Câu 4 (2 điểm) :Tính điểm trung bình của các môn 
Câu 5 (1 điểm): Dùng hàm để tìm điểm cao nhất
Câu 6 (1 điểm): Dùng hàm để tìm điểm thấp nhất.
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Đề 2

	Nội dung
	Điểm

	Câu1 : Nhập nội dung bảng tính theo mẫu trên. 
Câu 2: Lưu với tên và đường dẫn sau: D:\Khoi 7\Họ và tên học sinh-lớp 

Câu 3 :Dùng hàm để tính tổng ba môn của mỗi học sinh 
           =Sum(C3:E3)
     Sao chép công thức
Câu 4 :Tính điểm trung bình của các môn 
=Average(C3:E3)
      Sao chép công thức
Câu 5: Dùng hàm để tìm điểm cao nhất
=Max(C3:C9)
Sao chép công thức

Câu 6: Dùng hàm để tìm điểm thấp nhất.
=Min(C3:C9)

Sao chép công thức
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